
STUDY MATERIALS ON INFORMATION TECHNOLOGY IN BUSINESS 

B.COM 6
TH

 SEMESTER 

PAPER – 601 

UNIT – IV: APPLICATION SOFTWARE - I 

Word Processor 

A word processor is software or a device that allows users to create, edit, and print documents. It enables 

you to write text, store it electronically, display it on a screen, modify it by entering commands and 

characters from the keyboard, and print it.  

Of all computer applications, word processing is the most common. Today, most word processors are 

delivered either as a cloud service or as software that users can install on a PC or mobile device. 

 

History of Word Processing 

The earliest word processors were standalone machines similar to electric typewriters that debuted in the 

1960s. The great advantage of these early machines over using a typewriter was that you could make 

changes without retyping the entire document. Over time, the devices acquired more advanced features, such 

as the ability to save documents on a disk, elaborate formatting options, and spell-checking. 

While there are still some standalone word processors in use today, word processing began to move to 

personal computers in the 1980s. In the early days of the PC, a word processor called WordPerfect became 

one of the most widely used applications of any kind. Over time, however, What You See Is What You 

Get (WYSIWYG) word processors that showed users exactly what would print on their final documents 

became more popular. One of those WYSISWG word processors, Microsoft Word, became dominant in the 

1990s. 

Standard Features of Word Processors 

 

Word processors vary considerably, but all word processors, whether cloud-based or installed on a system, 

support the following basic features: 

Insert text: Allows you to insert text anywhere in the document. 

Delete text: Allows you to erase characters, words, lines, or pages. 

Cut and paste: Allows you to remove (cut) a section of text from one place in a document and insert (paste) 

it somewhere else. 

Copy: Allows you to duplicate a section of text. 

Page size and margins: Allows you to define various page sizes and margins, and the word processor will 

automatically readjust the text so that it fits. 

Search and replace: Allows you to direct the word processor to search for a particular word or phrase. You 

can also direct the word processor to replace one group of characters with another everywhere that the first 

group appears. 

Word wrap: Automatically moves to the next line when you have filled one line with text, and it will 

readjust text if you change the margins. 

Print: Allows you to send a document to a printer to get hard copy. 

File management: Provides file management capabilities that allow you to create, delete, move, and search 

for files. 

https://www.webopedia.com/TERM/D/document.html
https://www.webopedia.com/TERM/C/command.html
https://www.webopedia.com/TERM/C/cloud_services.html
https://www.webopedia.com/TERM/W/WYSIWYG.html
https://www.webopedia.com/TERM/C/cut.html
https://www.webopedia.com/TERM/P/paste.html
https://www.webopedia.com/TERM/C/copy.html
https://www.webopedia.com/TERM/S/search_and_replace.html
https://www.webopedia.com/TERM/W/word_wrap.html
https://www.webopedia.com/TERM/M/margins.html
https://www.webopedia.com/TERM/F/file_management_system.html


Font specifications: Allows you to change fonts within a document. For example, you can specify bold, 

italics, and underlining. Most word processors also let you change the font size and even the typeface. 

Windows: Allows you to edit two or more documents at the same time. Each document appears in a 

separate window. This is particularly valuable when working on a large project that consists of several 

different files. 

Spell checking: Identifies words that don't appear in a standard dictionary. 

 

Microsoft Word 

Microsoft Word or MS-WORD (often called Word) is a Graphical word processing program that users can 

type with. It is made by the computer company Microsoft. Its purpose is to allow users to type and save 

documents. Similar to other word processors, it has helpful tools to make documents. 

Brief History 

Microsoft word was released in 1983 as Multi-Tool Word. Its first version was based on the framework of 

Bravo which was world's first graphical writing program. 

Microsoft renamed Multi Tool Word to Microsoft Word, and then in October 1983, Microsoft released its 

first version for the IBM PC. 

In 1985, Microsoft ported it to the Macintosh which was different from its DOS-based counterpart, i.e. 

Macintosh offered various major interface changes. 

In 1989, Microsoft released a new version of Word for its Windows operating systems. It was the Microsoft 

Word who introduced the concept of WYSIWYG (What You See Is What You Get), i.e. it allowed to create 

and display bold and italics text. 

In 2014, Microsoft developed the source code for Microsoft Word for Windows 1.1a. 

Features 
 

The main features are: 

 

 You can create professional documents fast, using built-in and custom templates. 

 

 You can easily manage large documents using various features like the ability to create table of 

contents, index, and cross-references. 

 

 You can work on multiple documents simultaneously 

 

 With the help of mail merge, you can quickly create merge documents like mass mailings or mailing 

labels. 

 

 AutoCorrect and AutoFormat features catch typographical errors automatically and allow you to use 

predefined shortcuts and typing patterns to quickly format your documents. 
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 The print zoom facility scales a document on different paper sizes, and allows you to print out 

multiple pages on a single sheet of paper. 

 

 The nested tables feature supports putting one table inside another table. 

 

 You can export and save your word documents in PDF and XPS file format. 

 

Advantages of MS Word 

Availability 

One of the advantages of using Microsoft Word is that it is available practically everywhere. Word comes 

standard on many PCs. You can typically find it on your work computer, computers at school and your 

home PC. This makes it easy to save documents on a flash drive, take them with you and work on them 

somewhere else. If you need to do some work, you can usually find a computer with Word on it. 

Integration with Office Programs 

Another benefit of using Microsoft Word is that it easily integrates with other Microsoft Office programs. 

For example, if you have a spread sheet that you created on Microsoft Excel, you can easily paste it into a 

Word document. You can work with programs such as PowerPoint as well. This makes it possible to 

complete a wide array of computing tasks without having to spend time converting documents or files so 

that they are usable on other programs. 

 Instant Help 

While you are creating a document, Word also helps you make sure that it is the best it can be. When you 

misspell a word, Microsoft Word will immediately underline it. You can then click on the word and get 

suggested spellings. If you type a sentence that has poor grammar, Word will underline the sentence for you. 

This allows you to change the document while you are still working on it. 

Navigation Pane 

Microsoft Word offers an easy-to-use navigation pane at the top. This allows you to see visual 

representations of many of the functions that you might need. You can simply hold your mouse cursor over 

an icon to see exactly what it does. Then you can click on the buttons to initiate certain functions and tasks. 

Instead of having to scroll through multiple menus to find something, you can usually find what you need on 

the pane. 

Document Flexibility 

Word lets you create simple word-processing documents like letters and reports and make them as basic or 

as jazzed-up as you wish -- you can add color, use clip art, write in a variety of fonts and sizes, and use 

tables, borders and bullet formatting. Word also offers templates to help you create numerous other 



documents, such as calendars and greeting cards. You can also save documents in a variety of formats, 

including a Web page. 

Components of MS Word (Short Notes / Definition) 1 or 2 Marks 

Microsoft Office Button 

Microsoft Office Button is located on the top left corner of the window. It is a new user interface feature that 

replaced the traditional "File" menu. You can also see this button in Outlook while creating a new message, 

task, contact, etc. 

 

When you click the button it offers a list of commands to perform different tasks which are New, Open, 

Save, Save As, Print, Prepare, Send, Publish and Close. These commands are described below the following 

image. 

Title Bar 

It lies next to the Quick Access Toolbar. It displays the title of the currently open document or application. It 

is present on almost all windows displayed on your computer. So, if there are several windows across the 

screen, you can identify each window by looking at the title bar. In many graphical user interfaces, you can 

also move a window by dragging the title bar. 

 

Ribbon and Tabs 

The Ribbon is a user interface element which was introduced by Microsoft in Microsoft Office 2007. It is 

located below the Quick Access Toolbar and the Title Bar. It comprises seven tabs; Home, Insert, Page 

layout, References, Mailing, Review and View. Each tab has specific groups of related commands. It gives 

you quick access to the commonly used commands that you need to complete a task. 

 

 

 



Ruler 

The Ruler is located below the Ribbon around the edge of the document. It is used to change the format of 

the document, i.e. it helps you align the text, tables, graphics and other elements of your document. It uses 

inches or centimeters as the measurements unit and gives you an idea about the size of the document. 

 
 

The Menu Bar 

 

The Menu bar is directly below the Title bar and it displays the menu. The menu begins with the word File 

and continues with Edit, View, Insert, Format, Tools, Table, Window, and Help. You use the menu to give 

instructions to the software. Point with your mouse to the menu option and click the left mouse button to 

open a drop-down menu. You can now use the left and right arrow keys on your keyboard to move left and 

right across the Menu bar options. You can use the up and down arrow keys to move up and down the drop-

down menu. To select an option, highlight the item on the drop-down menu and press Enter. An ellipse after 

a menu item signifies additional options; if you select that option, a dialog box will appear. 

Bold, Italic and Underline Commands in MS Word 

These commands are given in the Font group in the Home tab. Their functions are given below; 

o Bold: It allows you to Bold the text of your document 

o Italic: It allows you to Italicize the text of your document 

o Underline: It allows you to underline the text of your document 

See the image: 

 

 

 



Paragraph Alignment 

One of the fundamental typographic specifications for laying out paragraphs is determining how they will 

appear in relation to the left and right margins. Word refers to this specification as alignment. There are four 

types of paragraph alignment you can set within Word: 

 Left-aligned. All lines in the paragraph butt up against the left text margin. No extra spaces are added 

to the line. The text of each line does not line up with the right margin, so traditional typesetting 

terminology often refers to left-aligned text as ragged right. 

 Center-aligned. All lines in a paragraph are centered between the left and right text margins. No extra 

spaces are added to the line. The text lines up with neither the left or right margins. 

 Right-aligned. All lines in a paragraph butt up against the right text margin. No extra spaces are 

added to the line. The text of each line does not line up with the left margin, so traditional typesetting 

terminology often refers to right-aligned text as ragged left. 

 Justified. All lines in a paragraph are expanded so they butt up against both the left and right text 

margins. Space is added, between words and characters, as necessary to fill out the line. In some 

typesetting references justified text is also referred to as "full justified." This alignment affects all 

lines in the paragraph except for the last one, which is left-aligned. 

You can change the alignment of any paragraph by using the appropriate tools on the Formatting toolbar or 

by displaying the Paragraph dialog box. 

 

Bullets and Numbering  

Bullets and numbering provide an excellent way to list and organise information in your documents. 

 

You should use a bulleted list when you have several related items, but the order in which the reader sees 

them doesn't matter. A numbered list should be used when you have several related items, but the order does 

matter. Depending on the type of document you are trying to create will depend on which method is 

appropriate. 

Shortcut Keys 

(Ctrl + Shift + L) - Applies the built-in "List Bullet" style to the selection. 

Two Types of Bullets and Numbering 

Quick Bullets - also known as single-level bullets or simple bullets 

Multi Level Bullets - also known as outline numbered lists. These are discussed in the Bullets & Numbering 

Advanced section. 

Quick Bullets and Numbering 

This type can be applied using the following buttons from the Formatting toolbar. 

 

Bullets - Adds bullets to or removes bullets from selected paragraphs. 

 

Numbering - Adds numbers to or removes numbers from selected paragraphs. 



Some more Terms (Short Notes / Brief Explaination 3 or 5 Marks 

Mail Merge 

Mail merge is a feature within most data processing applications that enables users to send a similar letter or 

document to multiple recipients. It enables connecting a single form template with a data source that 

contains information about the recipient’s name, address and other predefined and supported data. 

 

Mail merge primarily enables automating the process of sending bulk mail to customers, subscribers or 

general individuals. Mail merge works when a data file is stored that includes the information of the 

recipients to whom the letter is to be sent. This file can be a spreadsheet or database file containing separate 

fields for each different type of information to be merged within the letter. 

The second file is the word document or the letter template. The recipients' information on the letter 

template is kept empty. When the mail merge process is initiated, the recipients' data from spreadsheet or 

database is fetched and placed within the empty field in the letter, one by one, until all letters are created. 

Headers and Footers 

Headers and footers are typically used in multiple-page documents to display descriptive information. In 

addition to page numbers, a header or footer can contain information such as: The document name, the date 

and/or time you created or revised the document, an author name, a graphic, a draft or revision number. 

This descriptive information can appear in many different combinations. For example, the second page of a 

business letter typically contains a header with the name of the addressee, the page number, and the date. A 

report can contain a footer with the report name and a header with the page number and chapter name. A 

newsletter can contain a header with a title and logo on the first page and a footer with the title and page 

number on the pages that follow. Adjust your Headers and Footers via the “Header and Footer” selection on 

the View dropdown menu on the Menu toolbar. 

Headers and footers can help keep longer documents organized and make them easier to read. Text entered 

in the header or footer will appear on each page of the document. 

Merging Table Cells 

Word contains a handy table editor that allows you to create complex tables. One of the features of the table 

editor is that you can merge adjacent cells together. Merging cells simply means that the adjacent cells are 

thereafter treated as a single cell, even though they are not really a single cell. If the cells are on the same 

row, you can merge them together by following these steps: 

1. Select two or more adjacent cells, on the same row or same column, that you want to merge. 

2. Choose Merge Cells from the Table menu. 

You can also easily perform cell merging by using the Tables and Borders toolbar: 

1. Choose the Toolbars option from the View menu, and then make sure Tables and Borders is selected 

from the resulting submenu. 

2. Move the toolbar or adjust your document so you can see both your table and the toolbar. 

3. Click on the Eraser tool on the toolbar. This is the one just to the right of the tool that looks like a 

pencil. 



4. Click and drag to select the dividing lines between different cells. When you release the mouse 

button, the cells are merged. 

5. Use the Eraser tool to merge any other cells desired. 

6. Click on the Eraser tool again (on the toolbar) or press the Esc key. This turns off the Eraser tool. 

7. Close the Tables and Borders toolbar when finished. 

Font 

A font is a graphical representation of text that may include a different typeface, point size, weight, color, or 

design. The image shows some examples of different computer fonts. Software programs like Microsoft 

Word, Microsoft Excel, and WordPad allow users to change the font used when typing text in the document 

or spreadsheet, as do web designers. 

 

The height of characters in a font is measured in points, each point being approximately 1/72 inch. The 

width is measured by pitch, which refers to how many characters can fit in an inch. Common pitch values 

are 10 and 12. A font is said to be fixed pitch if every character has the same width. If the widths vary 

depending on the shape of the character, it is called a proportional font. 

 

Most applications that support text enable you to choose from among many fonts. Laser, ink-jet, and dot-

matrix printers offer the widest selection of fonts. These printers support a certain set of resident fonts, but 

you can expand this set by loading different fonts from software (soft fonts) or from font cartridges. 

 

Spelling and Grammar Tool in MS Word  

 

Sometimes when you are in hurry while typing a document, you might not have enough time to check your 

spellings. Spell-check works then and automatically corrects any wrong spellings or underlines them so you 

can correct them manually. It also checks the grammar in the document. It gives alternative/correct spellings 

to the words you might have confused and misspelled.  

 

How to Check Spelling and Grammar in Microsoft Word 

It is important to always check your documents for spelling and grammar mistakes before distribution. 

Fortunately, Word makes it easy. 

This feature works the same in all modern versions of Microsoft Word: 2010, 2013, and 2016. 

1. From the Proofing group on the Review tab, select Spelling & Grammar. 

 
2. Microsoft Word will look for spelling and grammar errors starting from the location of your cursor in 

the document. 
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3. If Word finds a spelling error, a navigation pane similar to the one below will appear: 

 

You then have the following options: 

o Ignore. To leave the text as is in a specific instance, but be notified if Microsoft Word finds 

the same thing again, click Ignore. 

o Ignore All. To leave the text as is in this and future instances, click Ignore All. 

o Add. Adding a word to your dictionary will prevent Microsoft Word from ever noting this 

word as being misspelled again. 

o Change. To correct only this instance of the misspelling, click Change. 

o Change All. To correct all instances of the misspelling throughout the document, 

click Change All. 

4. If Word finds a grammar error, a dialog box similar to the one below will appear: 

 

 
 



o Ignore. To leave the text as is in a specific instance, but be notified if Microsoft Word finds 

the same thing again, click Ignore. 

o Change. To accept Word's suggested correction, click Change. 

o At the bottom of the pane, you will see an explanation of the grammar error that Word has 

detected. 

5. A useful feature when checking spelling and grammar is Word's AutoCorrect feature. When Word 

indicates a word in a document may be misspelled or incorrect, with a squiggle under it, you can 

right-click the word to see suggestions. If a suggestion is correct, simply select it to replace the word. 

 

Macro is MS Word 

 

A macro is a series of commands that is recorded so it can be played back (executed) at a later time. Macros 

are great for reducing the amount of work you have to do on a series of steps that you perform frequently. 

Here's how to create and test a macro in Microsoft Word. 

 

In Word, you can automate frequently used tasks by creating and running macros. A macro is a series of 

commands and instructions that you group together as a single command to accomplish a task automatically. 

To save time on tasks you do often, bundle the steps into a macro. First, you record the macro. Then you can 

run the macro by clicking a button on the Quick Access Toolbar or pressing a combination of keys 

Everyone can use macros. You do not need any programming knowledge to use macros, and you can obtain 

macros without ever writing any code yourself. The macros that can help you do your work faster and easier 

can be obtained and installed in several ways, including the following. 

 Macros can be created by using the Macro Recorder, which records the steps that you perform 

and translates them into macro code. 

 If you can verbally describe what you want a macro to do, you can post a request to the Office 

Programming forum, and one or more of the experts who will read your request will be happy to 

write the macro for you. 

 The code of a macro can be copied as text from a reliable trustworthy source and added to the 

New Macros module of a template, from which it will always be available. 

 Macros that are stored in a template that you obtain from a reliable trustworthy source can be 

made available by installing the template or by using the Organizer to copy the applicable 

module into an installed template. 

http://answers.microsoft.com/en-us/office/forum/customize
http://answers.microsoft.com/en-us/office/forum/customize


Hyperlink in MS Word 

In Microsoft Word, there are times when a link to a web page is required. Or sometimes, a link to a location 

in the same document is needed as some are quite lengthy. Links can be useful for directing others who read 

the document to a specific site or adding a bibliography to a school assignment. Adding this type of link, 

called a hyperlink, can be done by following the steps below. 

A hyperlink in a Microsoft Word document enables readers to jump from the link to a different place in the 

document, to a different file or website, or to a new email message. In Word documents, hyperlink text is a 

different color than other text and is underlined. When you hover over a hyperlink, a preview shows where 

the link goes. When you select the link, you're directed to the other content. 

Inserting a hyperlink 

1. Open Microsoft Word. 

2. Type the appropriate text in the Word document. 

3. With your mouse or keyboard, highlight the text you want to turn into a hyperlink.  

4. In the menu bar or Ribbon at the top of the Word program window, click the Insert tab. 

5. On the Insert tab, in the Links section, click the Hyperlink or Link option. 

6. In the Insert Hyperlink window, type in the web page address you want to set the highlighted text 

to link to in the Address text field, then click OK. 

Folder 

In computers, a folder is the virtual location for applications, documents, data or other sub-folders. Folders 

help in storing and organizing files and data in the computer. The term is most commonly used with 

graphical user interface operating systems. 

Folders in computer science function similarly to real-world physical folders. Folders can store and organize 

different types of applications, files or libraries. Folders can also contain other folders, which in turn could 

contain other folders or files. Due to the manner in which folders organize and store data within the file 

system of the storage media, folders are also known as file directories or simply directories. There is no limit 

on the number of folders or sub-folders that can be created. Upon opening a folder, one can see how the data 

or files are organized. 

Although folders can contain large amounts of data, they do not take up any disk space. The reason for this 

is because folders are pointers to file locations within the file system of the computer. Most operating 

systems, upon right clicking the folder, provide information on the folder along with its properties. Folders 

can also be hidden from users, just as files can. 

Folders provide a useful aid in organizing the data found in the system according to the user preferences. It 

also helps in searching for data, if properly organized. 
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Difference between Undo and Redo 

 

Undo Redo 

1. Undo Action is used to cancel the last 

action performed 

2. Use short key command CTRL + Z  

3. The Undo option can be selected by 

clicking the Undo Button having clockwise 

arrow on the standard toolbar.  

1. Redo Button is used to repeat the last 

action performed. 

2. Used short key command CTRL + Y 

3. The Redo Button can be selected by 

clicking the Redo Button having clockwise 

arrow on the standard toolbar. 

 

Difference between Save and Save-As 

 

Save Save As 

1. To save the document in the same name in 

the default place. 

2. Used short cut key command CTRL + S if 

the document is titled/untitled document.  

3. Save option related with file name its 

location and keep as it is made  

1. To save the current file with a different 

name and different location. 

2. Used short cut key command CTRL + S if 

document is titled. 

 

3. Save as option related with name of the file 

and its location. 

 

Difference between Cut, Copy and Paste 

Cut: Cut is used to remove the contents of a document. Their hidden activity is to move documents from 

one location to another location. The cut option cane be selected by clicking the cut button from the Bar 

Menu. Short key command is CTRL + X. 

Copy: Copy means just copy the files or documents. The copy option can be selected by clicking the copy 

button from the Bar Menu. Short key command is CTRL + C. 

Paste: To paste the document in a particular location. Paste option is used after copy/cut option action is 

performed. The paste option can be selected by clicking the paste button from the Bar Menu. Short key 

command is CTRL + V. 


